Troubleshooting Guide
This guide describes the action to take when a paper jam or other problem occurs.

ComColor GD Series
9630/9630R/9631/9631R/7330/7330R
This device is compliant with the substance emission inspections of the German environmental label "RAL-UZ171".

CAUTION
After reading this guide, keep it handy for future reference. The "Safety Precautions" are provided in the supplemental Safety Information. Be sure to read through them prior to use.
Thank you for your purchase of a ComColor GD Series product.
This guide describes the possible causes and solutions for problems that can occur when using this machine.
Keep this guide handy, such as near the machine, for easy reference.

The five guides described below are supplied with this machine.

● **Quick Guide**
  This guide describes basic machine operations and how to replace consumables.
  Keep this guide handy, such as near the machine, for easy reference.
  Start by reading this guide.

● **User’s Guide**
  This guide describes handling precautions and specifications, as well as the operations and settings of each function.
  Read this guide for a more detailed understanding of the machine.

● **Administrator’s Guide**
  This guide describes the machine settings and optional equipment to be configured by the administrator.

● **Troubleshooting Guide (this guide)**
  This guide describes the actions to take when a paper jam or other problem occurs.

● **Safety Information**
  This guide describes safety precautions and specifications.

About This Guide
(1) This guide may not be reproduced in whole or in part without the permission of RISO KAGAKU CORPORATION.
(2) The contents of this manual may be changed without prior notice due to product improvements.
(3) RISO KAGAKU CORPORATION shall not be liable for any consequence of using this guide or the machine.

Trademark Credits
Microsoft, Windows, and Windows Server are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Mac, Mac OS, and Safari are trademarks of Apple Inc.
Adobe, the Adobe logo, PostScript, and PostScript 3 are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
ColorSet is a trademark of Monotype Imaging Inc. registered in the U.S. Patent & Trademark Office and may be registered in certain jurisdictions.
FeliCa is a registered trademark of Sony Corporation.
Mifare is a registered trademark of Royal Philips Electronics.

, ComColor, and FORCEJET are trademarks or registered trademarks of RISO KAGAKU CORPORATION in the United States and other countries.
Other corporate names and/or trademarks are either registered trademarks or trademarks of each company, respectively.

Acquisition of Color Universal Design Certification
The ComColor GD series (machine and optional equipment*) are certified for being manufactured in consideration of Color Universal Design, which improves visibility for more people regardless of individual differences in color perception, by the Color Universal Design Organization (CUDO).
* Certified optional equipment:
  Scanner / Face down finisher / High capacity feeder / High capacity stacker
Symbols, Notations, and Screenshots Used in This Guide

■ Symbols Used in This Guide

⚠ Indicates cautions that should be noted for safe use of this machine.

🚫 Indicates important items that should be noted or are prohibited.

📚 Indicates useful or additional information.

■ Names of Keys and Buttons

The names of hard keys on the operation panel and buttons/items on the touch panel screen or computer window are indicated with square brackets [ ].

● Operation Panel

Example: Press the [Stop] key.

● Touch Panel Screen

Example: Touch [Color Mode].

● Computer Window

Example: Select the [Mixed Size Original] check box.

■ Names of Optional Equipment

In this guide, the names of the optional equipment are described using a generic term as shown below. The specific name for each item of equipment is used when its unique features are explained.

<table>
<thead>
<tr>
<th>Name Used in This Guide</th>
<th>Optional Equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Tray</td>
<td>High capacity feeder</td>
</tr>
<tr>
<td>Stacking tray*</td>
<td>Auto-control stacking tray</td>
</tr>
<tr>
<td></td>
<td>Wide stacking tray</td>
</tr>
<tr>
<td></td>
<td>High capacity stacker</td>
</tr>
</tbody>
</table>

* Optional stacking tray connected to the right side of the machine.

■ Illustrations and Operating Procedures in This Guide

- The operating procedures, screenshots, and illustrations in this guide are for the ComColor GD9630/GD9630R with the optional scanner connected.
- The screenshots and illustrations in this guide may vary depending on the machine model and usage environment, including the connected optional equipment.
Contents

About This Guide ............................................................................................................... 1
Symbols, Notations, and Screenshots Used in This Guide ........................................... 2

Touch Panel Display ......................................................................................................... 5
[Home1] Screen .................................................................................................................. 5
Status Area ......................................................................................................................... 6
Job List Icons ..................................................................................................................... 7

Chapter 1 Messages ........................................................................................................ 1-1
Error Messages on the Touch Panel .................................................................................. 1-1
Examples of the Messages ............................................................................................... 1-2
Service Call ....................................................................................................................... 1-2
Unit Error .......................................................................................................................... 1-2
Paper Jam .......................................................................................................................... 1-3
Consumable Error ............................................................................................................. 1-4
Installation Error .............................................................................................................. 1-4
Warning ............................................................................................................................... 1-6
Information ......................................................................................................................... 1-11

Chapter 2 Troubleshooting ............................................................................................... 2-1
Paper Jams ........................................................................................................................ 2-4
Precautions When Removing Jammed Paper .................................................................... 2-5
Frequent Paper Jams ........................................................................................................... 2-6
Paper Feed Path .................................................................................................................. 2-7
General Troubleshooting for This Machine ...................................................................... 2-9
Troubleshooting for the Printer Driver and Printing .......................................................... 2-13
Troubleshooting for Copying ............................................................................................ 2-16
Troubleshooting for Scanning .......................................................................................... 2-17
Troubleshooting for Storage and USB ............................................................................. 2-18
Troubleshooting for the Multifunction Finisher and Face Down Finisher ....................... 2-20
Stapler Jams (Multifunction Finisher) .............................................................................. 2-21
Stapler Jams (Face Down Finisher) .................................................................................. 2-23
Troubleshooting for the Feed Tray .................................................................................. 2-24
Troubleshooting for the High Capacity Feeder ................................................................. 2-25
Troubleshooting for the High Capacity Stacker ................................................................. 2-25
Troubleshooting for the IC Card Reader .......................................................................... 2-26
Other Problems ................................................................................................................ 2-27
Troubleshooting for the Optional PS Kit ......................................................................... 2-29

Chapter 3 Maintenance ................................................................................................... 3-1
Replacing the Staple Cartridge ......................................................................................... 3-1
The touch panel allows you to perform operations and check the current status of the machine. Use the information described in this section to help with troubleshooting.

[Home1] Screen

On the [Home1] screen, press a mode button to access the settings and functions for that mode. You can check the information described below on each mode button or on the [System Info] screen.

When the lock icon is displayed in the top right corner of the mode button

The lock icon displayed on a mode button indicates that you must log in to access that mode.

- The administrator configures whether user login is required for each mode.

When a mode button is grayed out

Buttons for modes that the current user is not authorized to use are grayed out.

- The administrator configures the mode access rights for each user.

When a mode button is not displayed

If the administrator sets a mode button to [OFF] in [Home Screen Customization], that mode button is not displayed.

- [Admin Menu] is displayed only when the user is logged in as an administrator.
- Depending on the connection status or settings of equipment, the buttons for each mode may not be displayed.

[Copy] button and [Scan] button are hidden.
You can touch [System Info] on the [Home1] screen to check information about the consumables, machine, user, and license. The [Consumables] screen displays the status of the ink and paper.

- [User Info] is displayed only when a user is logged in.

### Status Area

The information described below is displayed in the status bar on the touch panel.

1. **User name**
   - The name of the user currently logged in is displayed.

2. **Printer status**
   - The current status of the machine is indicated with a description such as [Idle], [Printing], [Error], or [Some Units Unavailable].

3. **Offline**
   - This icon is displayed when [Online/Offline] is set to [OFF]. While the icon is displayed, the machine does not receive jobs.

4. **FORCEJET™ link icon**
   - This icon indicates whether all parts required for printing are working correctly. The display will differ depending on the consumable or configured details.
   - (ON): Using RISO ink
   - (ON): Using non-RISO ink (Ink information is entered.)
   - (Flashing): Using non-RISO ink (Ink information is not entered.)
   - For more information on setting the ink information, see "The [Ink Information Input] screen is displayed." (p. 2-28).

5. **Remaining ink indicator**
   - The bar of each ink indicates the amount of remaining ink. When the bar starts flashing, it is the time to replace the ink cartridge. Prepare a new ink cartridge for the color that flashes.

- The amount of remaining ink cannot be displayed when using non-RISO ink. [—] is displayed instead of the remaining ink indicator.
Job List Icons

The job list on the [Finished] screen displays the following icons according to the job type along with the document name/job name.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Job Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>Copy job</td>
</tr>
<tr>
<td>📄</td>
<td>Print job</td>
</tr>
<tr>
<td>📦</td>
<td>Scan (Mail) job</td>
</tr>
<tr>
<td>📦</td>
<td>Scan (PC) job</td>
</tr>
<tr>
<td>📦</td>
<td>Scan (Console) job</td>
</tr>
<tr>
<td>🗂</td>
<td>Storage (Save/Load) job</td>
</tr>
<tr>
<td>📆</td>
<td>USB (Save/Load) job</td>
</tr>
<tr>
<td>🗝</td>
<td>Job with a PIN code</td>
</tr>
<tr>
<td>💼</td>
<td>PS job</td>
</tr>
<tr>
<td>🛠️</td>
<td>Broken job (Broken data or data with problems)</td>
</tr>
</tbody>
</table>
Chapter 1 Messages

This chapter describes the reasons why the error lamp flashes on the operation panel and messages appear on the touch panel, and what actions to take.

When the message is displayed, resolve the problem following the instructions in the displayed message.

Error Messages on the Touch Panel

A description of the problem and instructions for resolving the problem are displayed, as shown in the illustration below.

• An alphanumeric error code is displayed at the top of the error message screen. Be sure to mention this error code when contacting your service representative.
  - The first letter of the error code indicates the type of problem.
  - The numbers vary depending on the location of the problem.
Examples of the Messages

The following are examples of messages. Follow the instructions in the displayed messages to resolve the problems.

- [Cancel] and [Continue] may be displayed on some message screens. Touch [Cancel] to stop the current operation. Touch [Continue] to resume the current operation.

<table>
<thead>
<tr>
<th>&lt;S000-0000&gt;Service Call</th>
</tr>
</thead>
<tbody>
<tr>
<td>These error messages are displayed when inspection or repair is required by a service representative.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>A problem has occurred. Press the Reset key, or turn the power off and on again with the power key on the operation panel. If the problem persists, contact your dealer.</td>
<td>A problem has occurred. Press the [Reset] key on the operation panel. If this still does not solve the problem, press the [Power] key on the operation panel to restart the machine. If the above two operations for recovery do not solve the error, contact your dealer or authorized service representative. Be sure to mention the error code displayed on the touch panel when contacting your dealer or authorized service representative.</td>
</tr>
<tr>
<td>Not enough space in memory. Turn the power off and on again with the power key on the operation panel.</td>
<td>The machine cannot be used because there is not enough available space on the internal hard disk. Press the [Power] key on the operation panel to restart the machine. If this does not solve the problem, contact your dealer or authorized service representative. Be sure to mention the error code displayed on the touch panel when contacting your dealer or authorized service representative.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&lt;U000-0000&gt;Unit Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>These error messages are displayed when repair is required by a service representative.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>A problem has occurred on the standard tray. You can use another tray to continue printing.</td>
<td>A problem has occurred with the standard tray. Touch [Change Tray] and specify a different paper tray.</td>
</tr>
<tr>
<td>A problem has occurred on the paper tray. You can use the standard tray to continue printing.</td>
<td>A problem has occurred with the feed tray. Touch [Change Tray] and specify the standard tray as the paper tray.</td>
</tr>
<tr>
<td>A problem has occurred on feed tray 1 (feed tray 2, feed tray 3). To solve the problem, remove the jammed paper. You can use another tray to continue printing.</td>
<td>A paper jam occurred in the feed tray. See &quot;Troubleshooting for the Feed Tray&quot; (p. 2-24), and remove the jammed paper. To continue printing with another tray, touch [Change Tray] and specify a different paper tray.</td>
</tr>
</tbody>
</table>
### Paper Jam

These error messages are displayed when there is a paper jam.

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>A problem has occurred on feed tray 1 (feed tray 2, feed tray 3). To solve the problem, remove the jammed paper, and press the Reset key. Printing using another tray is possible.</td>
<td>A paper jam occurred in the feed tray. See &quot;Troubleshooting for the Feed Tray&quot; (p. 2-24) to remove the jammed paper, and press the [Reset] key on the operation panel. If this still does not solve the problem, press the [Power] key on the operation panel to restart the machine. If the above two operations for recovery do not solve the error, contact your dealer or authorized service representative. Be sure to mention the error code displayed on the touch panel when contacting your dealer or authorized service representative. To continue printing with a different paper tray, press the [Reset] key on the operation panel, change the settings, and send the data.</td>
</tr>
<tr>
<td>The external controller has an error. Check.</td>
<td>An error has occurred with the print controller (ComColor Express FS2000C) or the print controller is not connected properly. Press the [Reset] key on the operation panel to turn off the display of the error message and check the LED indicator of the print controller and the connections of its cables.</td>
</tr>
</tbody>
</table>

<X000-0000> Paper Jam

These error messages are displayed when there is a paper jam.

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buttons indicate paper jam locations. To display how to fix, touch the button.</td>
<td>Paper is jammed inside the machine, or no paper or multiple sheets of paper were fed into the machine. Touch the button indicating the location of the paper jam to display how to remove the jammed paper, and follow the instructions. For more information, see &quot;Paper Jams&quot; (p. 2-4).</td>
</tr>
</tbody>
</table>
**<Y000-0000>Consumable Error**
These error messages are displayed when it is time to replace consumables or parts that require periodic replacement.

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add staples to the Face Down Finisher.</td>
<td>There are no more staples in the face down finisher. See &quot;Replacing the Staple Cartridge&quot; (p. 3-1), and follow the procedure to replace the staple cartridge.</td>
</tr>
<tr>
<td>Punch dust in the finisher is full. Open the front cover of the finisher, and dispose of punch dust.</td>
<td>The punching box becomes full of punching trash. See &quot;Cleaning the Punching Box&quot; (p. 3-5) and dispose all of the punching trash.</td>
</tr>
<tr>
<td>Open the front cover of the finisher, and add staples.</td>
<td>No more staples are left in the multifunction finisher. See &quot;Replacing the Staple Cartridge&quot; (p. 3-1) and add staples.</td>
</tr>
<tr>
<td>Open the front cover of the finisher, and add staples (front side, back side) for stapling booklets.</td>
<td></td>
</tr>
<tr>
<td>Replace the ink cartridge. Do not set the removed one to prevent failure.</td>
<td>Replace the displayed ink cartridge with the new one. For more information, see &quot;Ink Cartridge Replacement&quot; in the &quot;User's Guide&quot;.</td>
</tr>
<tr>
<td>The expiration date of the ink cartridge has expired. Replace the ink cartridge.</td>
<td></td>
</tr>
</tbody>
</table>

**<Z000-0000>Installation Error**
These error messages are displayed when a cover or tray is not completely closed or an ink cartridge is not properly installed.

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set ink cartridges.</td>
<td>No ink cartridge has been installed, or a non-RISO ink has been installed. Install a RISO ink cartridge, or contact your administrator.</td>
</tr>
<tr>
<td>Different color ink is set. Replace the ink cartridge.</td>
<td>The type or color of the installed ink cartridge is not correct. Check the installation position and the color and type of the installed ink cartridge, and install the ink cartridge properly.</td>
</tr>
<tr>
<td>The ink cartridge is not correct. Replace the ink cartridge.</td>
<td>If the wrong ink cartridge has been installed, remove it, wipe the ink port clean, attach the cap, and store it horizontally in the proper orientation.</td>
</tr>
</tbody>
</table>
Check the Stripper Unit.

The stripper unit is not installed properly.
Reinstall the stripper unit.

**Installing the stripper unit**

1. Lower the stripper lock knob (①) to unlock the stripper unit.

2. Press the stripper release lever (②) and remove the stripper unit.

3. Reinstall the stripper unit.

   - Make sure that the stripper unit is fully inserted.

4. Lift the stripper lock knob to lock the stripper unit.
When the stripper lock knob cannot be locked, the stripper unit is not fully inserted.
Make sure that the stripper unit is fully inserted.
### Warning

These warning messages are displayed when there is no more paper, the output tray is full, a peripheral device is not connected, or there is another problem.

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>The stacking tray of High Capacity Stacker is not set. Set the stacking tray.</td>
<td>The stacking tray is not set on the high capacity stacker. After setting the stacking tray on the carriage, return this to the high capacity stacker.</td>
</tr>
<tr>
<td><em>&lt;W000-0000&gt;</em> Warning</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set paper.</strong></td>
<td>The paper specified for the job is not loaded in the tray available for auto selection. Load the corresponding type and size of paper in the tray available for auto selection. Otherwise, touch [Change Tray] and change [Paper Selection] to a setting other than [Auto], or enable [Auto Selection] for a tray loaded with the specified paper.</td>
</tr>
<tr>
<td><strong>Auto tray selection is not available. Select a paper tray, and press the Start key.</strong></td>
<td>Auto selection is not performed if it is not enabled for any of the trays, even when paper tray selection is set to [Auto]. Touch [Paper Selection] and select the tray, or enable [Auto Selection] for the required tray.</td>
</tr>
<tr>
<td>The paper size may not be correct. Check the standard tray paper guide, tray, or paper size setting.</td>
<td>The size of paper specified for the job is not loaded. Load the specified size of paper. Otherwise, touch [Change Tray] and enable [Auto Selection] for a tray loaded with the specified paper.</td>
</tr>
<tr>
<td>The Standard Tray (Feed Tray 1, Feed Tray 2, Feed Tray 3) is not available. You can use another tray to continue printing.</td>
<td>A problem has occurred with the standard tray (or with feed tray 1, feed tray 2, or feed tray 3). Touch [Change Tray] and specify a different paper tray.</td>
</tr>
<tr>
<td><strong>Job name:</strong> This paper size cannot be output to the specified tray. Change the output tray or paper size. This job was deleted.</td>
<td>Touch [Close], change the settings, and send the data again. For more information on the paper sizes that can be used with each tray, see &quot;Printing Paper&quot; in the &quot;Safety Information&quot;.</td>
</tr>
<tr>
<td>This paper size cannot be output to the current output tray. Check the orientation or settings of the set paper.</td>
<td>Touch [Close], change the settings, and send the data again. For more information on the paper sizes that can be used with the output tray, see &quot;Printing Paper&quot; in the &quot;Safety Information&quot;.</td>
</tr>
<tr>
<td>This paper size cannot be output with offset output. Check the orientation or settings of the set paper.</td>
<td>Touch [Close], change the settings, and send the data again. For more information on the paper that can be used with offset output, see &quot;Printing Paper&quot; in the &quot;Safety Information&quot;.</td>
</tr>
<tr>
<td>There is no tray to which paper can be output. Remove paper.</td>
<td>The paper output to each tray exceeds the maximum load capacity. Remove paper.</td>
</tr>
<tr>
<td>Message</td>
<td>Action to Take</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| An error has occurred on the scanner.                                  | An error has occurred on the scanner.  
  Touch [Confirm]. If this message is displayed while scanning an original, scan the original again.  
  If the error message does not disappear after touching [Confirm], press the [Power] key on the operation panel to restart the machine. |
| Failed to save the scan file. Check the save destination setting.       | The scanned data could not be saved. Check the items below, and scan the original again.  
  - Network settings of the destination server  
  - Problems with the destination server  
  - Network cable connections  
  - [Destination] settings for the scanned data |
| Failed to save the scan file. The file size exceeds the upper limit, or the file name exists. Check. | The scanned data could not be saved. Check the items below, and scan the original again.  
  If a file with the same name already exists, change the file name.  
  If the file size of the scanned data exceeds the upper limit, reduce the number of pages in the original, or change the save format. |
| A USB drive is not set. Set a USB drive, and touch "Retry".             | A USB flash drive is not connected to the machine. To save to a USB flash drive, connect it to the machine, and touch [Retry].  
  To cancel saving to the USB flash drive, touch [Cancel].  
  To save to the internal hard disk of the machine, touch [Save to Internal HDD]. |
| Failed to save to USB drive. The suspected causes are:                 | You attempted to save the file using a file name that already exists on the USB flash drive.  
  Touch [Close] or [Cancel] and change the file name, or touch [Save to Internal HDD] to save the file to the internal hard disk of the machine.  
  - There is not enough space in the USB flash drive. Either change the destination to the internal hard disk of the machine, or delete unnecessary data from the USB flash drive to free up enough space, and then save the data again.  
  - The USB flash drive is set to write protected. Touch [Close] or [Cancel] to cancel saving to the USB flash drive, or touch [Save to Internal HDD] to save the file to the internal hard disk of the machine. |
| A file with the same name exists in the save destination. Do you want to overwrite? | You attempted to save the file using a file name that already exists on the USB flash drive.  
  Touch [Continue] to overwrite the existing file. To change the file name and save, touch [Cancel] and save the file again. |
<p>| This paper size cannot be output with the current booklet setting. Check the orientation or settings of the set paper. | Touch [Close], change the settings, and send the data again. For more information on the paper sizes and orientations that can be used when creating booklets, see &quot;Booklet&quot; in the &quot;User's Guide&quot;. |</p>
<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
</table>
| This paper size cannot be output with the current staple/punch setting. Check the orientation or settings of the set paper. | Touch [Close], change the settings, and send the data again. For more information on the paper sizes and orientations that can be used when stapling, see the following.  
  • When using the face down finisher  
    “Staple” of the "User's Guide"  
  • When using the multifunction finisher  
    “Staple/Punch” of the "User's Guide" |
| Printing on envelopes is specified. Check whether duplex printing, finisher settings, or other settings that cannot be used in combination are configured. | You are trying to print on an envelope in a state where a setting that cannot be performed for the envelope job is specified. Cancel the following settings, and send the data again.  
  • Duplex printing  
  • Functions specified on the multifunction finisher  
  • Setting [Face Up/Down] to face down when using the multifunction finisher  
  In a state where [Thickness] for the type of paper is set to [Envelope], you are trying to print on paper other than an envelope. Touch [Change Tray] and change [Thickness] to [Standard]. |
<p>| A file containing a large amount of data is still processing. Press &quot;Continue&quot; button to allow processing to finish, or press &quot;Cancel&quot; button to delete the job. | A job with a large amount of data is being processed. When a job contains a large amount of data, it is recommended that you handle it as a waiting job or save it to storage before printing. |
| Not enough space in HDD. Delete unnecessary jobs to free up space in HDD. | The hard disk of the machine is full. Delete completed jobs or unnecessary documents in storage to free up space on the hard disk. |
| Job name: This job has been deleted. | The corresponding job was deleted on the RISO Console while it was suspended. Send the data again. |
| Job name: This job cannot be executed. Check the data type. (The job was deleted.) | The specified job cannot be printed because the file is used by the Barcode Area Definition Software. |
| The time of the Kerberos server may not be synchronized with that of the printer. | There is a time difference between the machine’s internal clock and the Kerberos server. Contact your administrator. The time can be synchronized by using [NTP Time Synchronization] in [Admin Menu]. |
| This is Non-Riso ink cartridge. Using Non-Riso ink may result in serious damage to the printer. Check your service provider's warranty/service agreement if any, as damage caused by Non-Riso supplies could be excluded from coverage. Do you wish to continue using this cartridge? | A non-RISO ink cartridge has been installed. Contact your administrator to determine whether or not to use this ink. To continue using the non-RISO ink cartridge, touch [Yes] and enter the appropriate values in the [Ink Information Input] screen which appears next. For more information, see “The [Ink Information Input] screen is displayed.” (p. 2-28). |</p>
<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>The staple unit (punch unit, top tray unit, stacking tray unit, booklet tray unit, tri-fold output tray unit) of the finisher is not connected. Check. (The job was deleted.)</td>
<td>Each unit (staple unit, punch unit, top tray unit, stacking tray unit, booklet tray unit, tri-fold output tray unit) of the multifunction finisher cannot be used. Contact your dealer or authorized service representative.</td>
</tr>
<tr>
<td>Failed to lower the Stacking Tray. Check the tray of the finisher.</td>
<td>Something may be obstructing the stacking tray. Make sure that nothing is placed below or near the tray.</td>
</tr>
<tr>
<td>Job name: Failed to lower the Stacking Tray. Check the tray of the finisher.</td>
<td>Each unit (staple unit, punch unit, top tray unit, stacking tray unit, booklet tray unit, tri-fold output tray unit) of the multifunction finisher cannot be used. Contact your dealer or authorized service representative. If you touch [Close], you can continue using the machine except for the unit that has an error.</td>
</tr>
<tr>
<td>Job name: Paper size that cannot be output with the Z-fold setting is included. Check the print data. (The job was deleted.)</td>
<td>A size of original that cannot be used with [Mixed Size Z-fold] is included. [Mixed Size Z-fold] can only be used with the combinations of A4 and A3, B5 and B4, and Letter-R and Ledger. Check the original size.</td>
</tr>
<tr>
<td>This paper size cannot be output with the current paper fold setting. Check the orientation or settings of the set paper.</td>
<td>Touch [Close], change the settings, and send the data again. For more information on the paper sizes and orientations that can be used when folding the paper, see &quot;Fold&quot; and &quot;Booklet Binding&quot; in the &quot;User's Guide&quot;.</td>
</tr>
<tr>
<td>Check the auto-control stacking tray.</td>
<td>The guides of the auto-control stacking tray are not properly set. Check.</td>
</tr>
<tr>
<td>Paper is not appropriately loaded in the stacking tray of High Capacity Stacker. Check the stacking tray.</td>
<td>The paper guides of the high capacity stacker are not set in their proper positions and the paper is not aligned. Check the printouts. To output irregular sized paper, it is necessary to register the paper size to the machine in advance. Contact your administrator for details.</td>
</tr>
<tr>
<td>Message</td>
<td>Action to Take</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Paper is left in the High Capacity Stack. Print cannot be run.</td>
<td>There is paper on the stacking tray of the high capacity stacker. When there is paper on the stacking tray, the paper guides cannot move to the appropriate positions for the next job. Remove paper.</td>
</tr>
<tr>
<td>Mixed size paper is stacked in the High Capacity Stack. Remove paper</td>
<td>• When the power is turned on or when recovering from the sleep mode, it is necessary to remove the paper on the stacking tray as otherwise the paper guides will not be able to move to their appropriate positions in accordance with the paper size. If you are not removing the printouts every time a print job is completed, it is recommended that the time until entering the sleep mode be set longer with [Power Saving Setting] in the administrator menu. For more information on the power saving setting, see &quot;Power Saving Setting&quot; in the &quot;Administrator's Guide&quot;.</td>
</tr>
<tr>
<td>Job Name: This job cannot be ejected in the stacking tray of High</td>
<td>The printouts do not come out as the job contains inappropriate settings for the high capacity stacker (paper size, mixed size originals, or containing settings that cannot be performed). Change the output tray, specify the paper size that can be output, or change the settings so that the sizes are not mixed.</td>
</tr>
<tr>
<td>Capacity Stack. Check the settings. (The job has been deleted.)</td>
<td></td>
</tr>
<tr>
<td>The High Capacity Feeder is overloaded with paper. Check the feed tray</td>
<td>Paper that exceeds the maximum number of sheets that can be loaded has been loaded in the high capacity feeder. Remove paper. For more information on the maximum number of sheets that can be loaded, see &quot;Printing Paper&quot; in the &quot;User's Guide&quot;.</td>
</tr>
<tr>
<td>Load paper in High Capacity Feeder or check the paper guides and paper</td>
<td>Load the paper in the high capacity feeder.</td>
</tr>
<tr>
<td>size settings.</td>
<td>The standard tray paper guides do not match the size of the paper. Match the standard tray paper guides with the size of the paper. Otherwise, touch [Change Tray] and check the paper settings.</td>
</tr>
<tr>
<td>The data including the following settings cannot be used with Overlay.</td>
<td>Overlay cannot be used if the selected overlay image contains the following settings. Touch [Close], cancel these settings, and save the data in the storage again. • Reproduction Size • Duplex • Staple / Punch • Combine • Image Repeat • Booklet • Booklet Binding • Fold • Mixed Size Original • Program • Add Cover • Auto Image Rotation</td>
</tr>
<tr>
<td>The Standard Tray (Feed Tray 1, Feed Tray 2, Feed Tray 3) is not</td>
<td>A problem has occurred with the standard tray (with feed tray 1, feed tray 2, or feed tray 3) in which the slip sheets or cover sheets are loaded. Touch [Close], check the standard tray (feed tray 1, feed tray 2, or feed tray 3), and send the data again.</td>
</tr>
<tr>
<td>available. (The job has been deleted.)</td>
<td></td>
</tr>
</tbody>
</table>
### Message | Action to Take
--- | ---
**IP address of LAN0 and LAN1, or network segment may be conflicting. Please check the network settings of LAN0 and LAN1.** | The same IP address (segment) is set to LAN0 and LAN1 of the machine. When assigning the IP addresses manually, assign a different IP address to LAN0 and LAN1. Check the IP address from [Network Setting (IPv4)] or [Network Setting (IPv6)] in [Admin Menu].

### <I000-0000>Information
These messages are displayed when machine maintenance is required.

<table>
<thead>
<tr>
<th>Message</th>
<th>Action to Take</th>
</tr>
</thead>
<tbody>
<tr>
<td>The drain tank must be replaced soon. Contact your dealer, and have a new drain tank ready.</td>
<td>The drain tank needs to be replaced. Contact your dealer or authorized service representative.</td>
</tr>
<tr>
<td>• Printing cannot be performed when the drain tank is full. Call for service immediately when this message is displayed.</td>
<td></td>
</tr>
<tr>
<td>The transfer belt is dirty. Leaving the belt dirty results in inaccurate printing. Contact your dealer.</td>
<td>The transfer belt needs to be cleaned. Contact your dealer or authorized service representative.</td>
</tr>
<tr>
<td>• The paper size and position cannot be detected when the transfer belt is dirty, resulting in improper printing. The cleaning operation needs to be performed by technical support staff. Call for service immediately when this message is displayed. Until the transfer belt is cleaned, the margins around the edges of the paper are 5 mm (7/32”), regardless of the printable area setting.</td>
<td></td>
</tr>
<tr>
<td>Parts of the Face Down Finisher need to be replaced. Contact your dealer.</td>
<td>Contact your dealer or authorized service representative. If you touch [Close], you can continue using the machine functions except for the face down finisher. Printing can be performed using a different stacking tray.</td>
</tr>
<tr>
<td>The ink cartridge is near expiration. Use or replace the ink cartridge soon.</td>
<td>For optimal printing quality, use the ink cartridge within 24 months from the date of manufacture (when preserved under room temperature).</td>
</tr>
</tbody>
</table>
## Chapter 2 Troubleshooting

This chapter describes what actions to take when problems occur. Use the information in this chapter to help with troubleshooting.

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper Jams</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>p. 2-4</td>
</tr>
<tr>
<td><strong>General Troubleshooting for This Machine</strong></td>
<td></td>
</tr>
<tr>
<td>The machine does not operate at all. / Nothing is displayed on the touch panel when the power is turned on.</td>
<td>p. 2-9</td>
</tr>
<tr>
<td>Nothing is displayed on the touch panel, even when the buttons of the operation panel are touched.</td>
<td>p. 2-9</td>
</tr>
<tr>
<td>The scanner does not operate.</td>
<td>p. 2-9</td>
</tr>
<tr>
<td>The printing results are light or dark.</td>
<td>p. 2-9</td>
</tr>
<tr>
<td>When copying or scanning, the original loaded in the ADF (automatic document feeder) is not fed properly.</td>
<td>p. 2-10</td>
</tr>
<tr>
<td>Prints or copies have white streaks or appear blurry.</td>
<td>p. 2-10</td>
</tr>
<tr>
<td>The output results are dirty or have black streaks.</td>
<td>p. 2-10</td>
</tr>
<tr>
<td>The copied or scanned data is blurred, or part of the data is not printed.</td>
<td>p. 2-10</td>
</tr>
<tr>
<td>The back of the original is visible.</td>
<td>p. 2-11</td>
</tr>
<tr>
<td>Moire interference occurs.</td>
<td>p. 2-11</td>
</tr>
<tr>
<td>No paper is fed. / The back of a card is damaged. / Multiple sheets of paper are fed.</td>
<td>p. 2-11</td>
</tr>
<tr>
<td>A multiple feeding error occurs although multiple feeding was not performed, or multiple feeding errors occur frequently.</td>
<td>p. 2-12</td>
</tr>
<tr>
<td>The paper becomes dirty. / Printing is not aligned properly.</td>
<td>p. 2-12</td>
</tr>
<tr>
<td><strong>Troubleshooting for the Printer Driver and Printing</strong></td>
<td></td>
</tr>
<tr>
<td>Cannot print from a computer.</td>
<td>p. 2-13</td>
</tr>
<tr>
<td>Cannot print properly on irregular sized paper.</td>
<td>p. 2-13</td>
</tr>
<tr>
<td>When printing a document with multiple pages, some pages are printed with an incorrect paper size.</td>
<td>p. 2-13</td>
</tr>
<tr>
<td>It takes a long time to print. / When printing multiple copies, the printer makes a beep sound after each copy is printed.</td>
<td>p. 2-13</td>
</tr>
<tr>
<td>The PIN code for a job is lost.</td>
<td>p. 2-13</td>
</tr>
<tr>
<td>[Full Color] and [Auto] are not displayed in the [Color Mode] menu on the printer driver screen.</td>
<td>p. 2-13</td>
</tr>
<tr>
<td>Cannot specify pages to print.</td>
<td>p. 2-14</td>
</tr>
<tr>
<td>Only one copy (page) is printed even though multiple copies (pages) are specified.</td>
<td>p. 2-14</td>
</tr>
<tr>
<td>Part of the image is missing.</td>
<td>p. 2-14</td>
</tr>
<tr>
<td>Cannot reprint a job on the [Job Status] screen.</td>
<td>p. 2-14</td>
</tr>
<tr>
<td>After interrupting a job or turning the machine off and back on, it is unknown how much printing was completed.</td>
<td>p. 2-14</td>
</tr>
<tr>
<td>Paper is loaded but the &quot;Set paper.&quot; error message is displayed.</td>
<td>p. 2-14</td>
</tr>
<tr>
<td>The results of color printing are poor.</td>
<td>p. 2-14</td>
</tr>
<tr>
<td>Printed images are light or faded.</td>
<td>p. 2-15</td>
</tr>
<tr>
<td>The paper edges become dirty.</td>
<td>p. 2-15</td>
</tr>
<tr>
<td>Images are bright or dark.</td>
<td>p. 2-15</td>
</tr>
<tr>
<td>Duplex printing cannot be performed using the paper loaded in the standard tray.</td>
<td>p. 2-15</td>
</tr>
<tr>
<td>The sent data became a broken job.</td>
<td>p. 2-15</td>
</tr>
</tbody>
</table>
## Troubleshooting for Copying

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>The colors of a barcode background or nearby images cannot be printed out.</td>
<td>p. 2-15</td>
</tr>
<tr>
<td>The layout order is not correct.</td>
<td>p. 2-15</td>
</tr>
</tbody>
</table>

## Troubleshooting for Scanning

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is no scanned data on the scan screen of the RISO Console.</td>
<td>p. 2-17</td>
</tr>
<tr>
<td>Part of the original is missing in the scanned data.</td>
<td>p. 2-17</td>
</tr>
<tr>
<td>The color mode is set to [Auto], but the machine does not identify color originals automatically.</td>
<td>p. 2-17</td>
</tr>
</tbody>
</table>

## Troubleshooting for Storage and USB

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files saved on a USB flash drive are not displayed on the printer.</td>
<td>p. 2-18</td>
</tr>
<tr>
<td>Cannot print properly on irregular sized paper.</td>
<td>p. 2-18</td>
</tr>
<tr>
<td>Paper is loaded but the &quot;Set paper.&quot; error message is displayed.</td>
<td>p. 2-18</td>
</tr>
<tr>
<td>The results of color printing are poor.</td>
<td>p. 2-18</td>
</tr>
<tr>
<td>Duplex printing cannot be performed using the paper loaded in the standard tray.</td>
<td>p. 2-19</td>
</tr>
<tr>
<td>Part of the original is missing in the copied data.</td>
<td>p. 2-19</td>
</tr>
<tr>
<td>Part of the original is missing in the scanned data.</td>
<td>p. 2-19</td>
</tr>
<tr>
<td>The color mode is set to [Auto], but the machine does not identify color originals automatically.</td>
<td>p. 2-19</td>
</tr>
</tbody>
</table>

## Troubleshooting for the Multifunction Finisher and Face Down Finisher

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>The multifunction finisher or face down finisher does not operate.</td>
<td>p. 2-20</td>
</tr>
<tr>
<td>When you copy the original, the paper is stapled at the wrong position.</td>
<td>p. 2-20</td>
</tr>
<tr>
<td>Staples do not penetrate well, e.g., they bend or crush. / Paper is not output from the face down finisher.</td>
<td>p. 2-20</td>
</tr>
<tr>
<td>A staple is jammed inside the machine.</td>
<td>p. 2-20</td>
</tr>
<tr>
<td>Sheets come out loosely stacked on the face down finisher. / Printouts are curled back.</td>
<td>p. 2-20</td>
</tr>
</tbody>
</table>

## Troubleshooting for the Feed Tray

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper is jammed in the feed tray. / The tray cannot be pulled out smoothly.</td>
<td>p. 2-24</td>
</tr>
</tbody>
</table>

## Troubleshooting for the High Capacity Feeder

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Although the paper in the high capacity feeder has run out, the standard tray does not descend to its lowermost position and stops midway.</td>
<td>p. 2-25</td>
</tr>
<tr>
<td>The paper feed guides cannot be adjusted and cause the paper to bend, warp, or be misaligned.</td>
<td>p. 2-25</td>
</tr>
</tbody>
</table>

## Troubleshooting for the High Capacity Stacker

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>The stacking tray does not descend and it is difficult to remove the printouts.</td>
<td>p. 2-25</td>
</tr>
<tr>
<td>The stacking tray descends each time a job is printed and it is not possible to continuously print.</td>
<td>p. 2-25</td>
</tr>
</tbody>
</table>

## Troubleshooting for the IC Card Reader

<table>
<thead>
<tr>
<th>Problem</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to log in using the IC card.</td>
<td>p. 2-26</td>
</tr>
<tr>
<td>A registered IC card is lost or missing.</td>
<td>p. 2-26</td>
</tr>
<tr>
<td>Problem</td>
<td>See</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Other Problems</td>
<td></td>
</tr>
<tr>
<td>The front cover does not open.</td>
<td>p. 2-27</td>
</tr>
<tr>
<td>The correct user name is not displayed when touching the index button on the [Login] screen.</td>
<td>p. 2-27</td>
</tr>
<tr>
<td>A job with a PIN code cannot be deleted.</td>
<td>p. 2-27</td>
</tr>
<tr>
<td>The printer does not wake up automatically.</td>
<td>p. 2-27</td>
</tr>
<tr>
<td>The RISO Console screen is not displayed.</td>
<td>p. 2-27</td>
</tr>
<tr>
<td>The [Ink Information Input] screen is displayed.</td>
<td>p. 2-28</td>
</tr>
<tr>
<td>Troubleshooting for the Optional PS Kit</td>
<td></td>
</tr>
<tr>
<td>Files saved on a USB flash drive are not displayed on the printer.</td>
<td>p. 2-29</td>
</tr>
<tr>
<td>It takes a long time to print when using Mac OS. / Printing cannot be performed with the current settings.</td>
<td>p. 2-29</td>
</tr>
<tr>
<td>When using Mac OS to print a document with multiple pages, some pages are printed with an incorrect paper size.</td>
<td>p. 2-29</td>
</tr>
<tr>
<td>When printing a PDF file directly from a USB flash drive, a paper with the texts &quot;Implementation limit exceeded&quot; is printed out.</td>
<td>p. 2-29</td>
</tr>
</tbody>
</table>

PS Kit FG10 is not supported in some regions.
Paper Jams

If a paper jam occurs in the machine or optional equipment, printing stops, the error lamp on the operation panel flashes in red, and the paper jam location is displayed on the touch panel. Follow the procedure displayed on the touch panel to remove the jammed paper and resume printing.

⚠️ CAUTION

Be careful of protruding parts and metal terminals when inserting your hand in the machine, such as when removing jammed paper. Otherwise, an injury might occur.

1. Touch the button indicating the location of the paper jam to display how to remove the jammed paper.

2. Follow the procedure displayed on the touch panel to remove the paper.
   Touch [Back] or [Next] to display the previous or next page.
   (The screenshots below are examples of the display when there is a paper jam.)

3. Touch [Close].
   Return to the screen in Step 1. Check that the button indicating the location where the paper was removed has disappeared.
   When all of the jammed paper is removed and the cover is closed, the error screen closes and the previous screen is displayed.

   • As long as alphabet buttons are displayed on the screen, paper still remains in the indicated locations. Repeat Steps 1 to 3 to remove the jammed paper.
Precautions When Removing Jammed Paper

- Slowly and carefully remove the jammed paper. Be careful not to leave pieces of paper in the machine.

- If a paper jam occurs when printing multiple sheets of paper, the sheet of paper that caused the paper jam as well as other sheets of paper may remain in the transfer path. When using an internal dial to remove jammed paper, turn the dial four or five times after removing the first sheet of paper, to check for other sheets of paper.

- The print heads are located inside the top of the paper removal opening. When removing jammed paper from the opening, avoid touching the print heads to prevent ink from getting on your hand or sleeve.
- Dial "C2" is used when the stacking tray is connected to the right of the machine.
- Depending on the jammed locations, it may be easier to remove the jammed paper if you roll up the paper little by little.
Frequent Paper Jams

If paper jams occur frequently, check the points listed below again.

- The paper on the standard tray or in the feed tray is within the maximum load capacity.
- The standard tray paper guides are positioned correctly and the paper is loaded properly.
- The paper that is actually loaded matches the [Paper Selection] settings.
- Usable paper is loaded.
  In particular, wrinkled or curled paper can cause paper jams, so do not use this type of paper.
- When using irregular sized paper, the paper size must be registered in advance in the administrator menu. Contact your administrator. To use unregistered irregular sized paper, select [Paper Selection] - [Paper Tray Setting] - [Paper Size], and specify the size in [Manual].
- Check if you are using paper that has already been printed on one side or is dark in color. In such case, the machine may incorrectly detect a single sheet as if it were multiple sheets of paper being fed. Set [Double-feed Check] to [OFF].

  - [Copy] screen  [Paper Selection]  [Paper Tray Setting]  set [Double-feed Check] to [OFF]
  - [Storage] - [Save] screen  select folder  [Save Document]  [Paper Selection]  [Paper Tray Setting]  set [Double-feed Check] to [OFF]

  - For more information on how to load paper and the types of paper that can be used, see "Loading the Paper" in the "User's Guide" and "Printing Paper" in the "Safety Information".
This section describes the path that paper travels through the machine during printing. See this information when removing jammed paper from the machine.

During printing, paper travels through the machine as shown in the illustration below.

- Solid line: Paper feed path during simplex printing
- Dashed line: Paper feed path during duplex printing

<When using the face down tray>
<When using the face down finisher>
<When using the stacking tray>

<When using the multifunction finisher>
The paper feed path inside the multifunction finisher is the same for simplex printing and duplex printing.

- The tray to which the printed materials are output will differ depending on the configured functions of the multifunction finisher.
- For more information on the paper feed path when the multifunction finisher is connected, see the next page.
When connected to the multifunction finisher
- When stapling
  ![Staple]

- When punching
  ![Punch]

- When stapling and punching
  ![Punch], [Staple]

When booklet binding/bi-folding
- When tri-folding
  ![Tri-fold]

- When Z-folding
  ![Z-fold]
General Troubleshooting for This Machine

This section describes how to troubleshoot general problems that may occur in the different modes.

⚠️ The machine does not operate at all. / Nothing is displayed on the touch panel when the power is turned on.

- Make sure that the main power switch is turned on.
- Make sure that the power plug of the machine is properly inserted into the electrical outlet.
- Make sure that the power cord is securely connected to the machine.
- Make sure that the power breaker has not been tripped.

⚠️ Nothing is displayed on the touch panel, even when the buttons of the operation panel are touched.

The machine may be in sleep state. The administrator may have configured the machine to automatically enter power saving mode when it has not been operated for a fixed period. Press the [Wake Up] key.

⚠️ The scanner does not operate.

- Make sure that the power plug of the scanner is properly inserted into the electrical outlet.
- Make sure that the USB cable is securely connected to the printer and scanner.

⚠️ The printing results are light or dark.

The density setting may not be configured properly.

For printing:
Adjust the [Print Density] setting in the [Image] tab on the printer driver screen.

For copying and scanning:
Configure the [Scanning Level] setting for copying according to the original.

[Copy] screen / [Scan] screen ➤ [Scanning Level]
[Storage] - [Save] screen / [USB] - [Save] screen ➤ select folder ➤ [Save Document] ➤ [Scanning Level]

If you are printing or copying, the paper type setting may not match the type of paper loaded in the standard tray or feed tray. Correctly configure the paper type.

For printing:

[Print] screen ➤ select job ➤ [Change Setting] in the sub menu ➤ [Paper Selection] ➤ [Paper Tray Setting] ➤ [Paper Type]

[Storage] - [Load] screen ➤ select folder ➤ select document ➤ [Change Setting] in the sub menu for the document ➤ [Paper Selection] ➤ [Paper Tray Setting] ➤ [Paper Type]


For copying:

[Copy] screen ➤ [Paper Selection] ➤ [Paper Tray Setting] ➤ [Paper Type]

[Storage] - [Save] screen ➤ select folder ➤ [Save Document] ➤ [Paper Selection] ➤ [Paper Tray Setting] ➤ [Paper Type]
When copying or scanning, the original loaded in the ADF (automatic document feeder) is not fed properly.

The original may be too small.
The minimum size original that can be loaded in the ADF is 100 mm × 148 mm (3 15/16" × 5 27/32"). If the original is too small, it may not be fed properly from the ADF, causing a paper jam. Load originals smaller than 100 mm × 148 mm (3 15/16" × 5 27/32") on the platen glass.

Prints or copies have white streaks or appear blurry.

The print heads may be clogged.
Perform [Print Head Cleaning] to unclog the print heads.

[Home1] screen ► [Maintenance] ► [Print Head Cleaning] ► [Normal Cleaning]
If this does not fix the problem, perform [Strong Cleaning].

The output results are dirty or have black streaks.

Paper that is unusable for printing or copying may have been loaded in the machine.
Check the type of the paper loaded in the standard tray or feed tray. For more information, see "Printing Paper" in the "Safety Information".

You may be using curled paper for printing or copying.
Curling paper can come in contact with the print heads, causing the paper to become dirty. This can damage the print heads, so do not use curled paper.

If you are copying or scanning, the [Scanning Level] setting may be too dark.
Adjust the [Scanning Level] setting.

[Copy] screen / [Scan] screen ► [Scanning Level]
[Storage] - [Save] screen / [USB] - [Save] screen ► select folder ► [Save Document] ► [Scanning Level]

If you are copying or scanning, the original cover may not have been closed securely.
Close the original cover of the scanner securely to prevent any light from entering.

If you are copying or scanning, the parts listed below may be dirty.
Wipe them with a soft cloth.

The copied or scanned data is blurred, or part of the data is not printed.

The original may not be in complete contact with the platen glass.
Close the original cover so that the original is completely flat against the platen glass.

The scanner may have been subjected to vibration.
Scan the original again without subjecting the scanner to vibration.

If you are copying, the paper may be moist.
If the paper contains moisture, part of the copied data may not be printed or it may be blurred. Use dry paper.

• Even if the size of the original is appropriate, the paper thickness, type or other characteristics may prevent it from being scanned with the ADF. For more information, see "Originals" in the "Safety Information".

• Any dust, debris, ink, glue, or correcting fluid adhering to the white sheet of the ADF, the platen glass, or scanner glass can result in the copied or scanned data that is not clean. Perform periodic cleaning.

2-10
The back of the original is visible.

If you are copying or scanning an original on thin paper, the image on the back side of the original or on the next page may be captured in the image data.
- Adjust [Scanning Level] to a lighter setting.
- Place a black piece of paper on the back side of the original and copy or scan the original again.
- When copying or scanning an original with a base color, such as a newspaper or magazine, you can use the [Base Color Level] setting to adjust the base color level.

Moire interference occurs.

Moire interference (meshed shadow) can easily occur when copying or scanning images such as photographs that have been subjected to screen processing for publication.
Moire interference can be reduced by configuring the [Moire Elimination] setting.

No paper is fed. / The back of a card is damaged. / Multiple sheets of paper are fed.

The [Thickness] setting in [Paper Type] may not match the paper properties (paper thickness). Correctly configure the [Thickness] setting in [Paper Type].

For printing:
- [Print] screen ▶ select job ▶ [Change Setting] in the sub menu ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ [Paper Type] ▶ [Thickness]
- [Storage] - [Load] screen ▶ select folder ▶ select document ▶ [Change Setting] in the sub menu for the document ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ [Paper Type] ▶ [Thickness]

For copying:
- [Copy] screen ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ [Paper Type] ▶ [Thickness]
- [Storage] - [Save] screen ▶ select folder ▶ [Save Document] ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ [Paper Type] ▶ [Thickness]

For more information, see "Paper Selection" in the "User's Guide".

The paper feed pressure may need to be adjusted to suit the paper thickness.
Set the paper feed pressure adjustment lever to "＊ (NORMAL)" or "☆☆ (CARD)" based on the type of paper that is loaded.

Normally, set the lever to "＊ (NORMAL)". If paper feeding is a problem, set this to "☆☆ (CARD)". For more information, see "Loading the Paper in the Standard Tray" in the "User's Guide".
The angle of the stripper plate may not be properly adjusted.
Turn the stripper plate angle adjustment dial to adjust the angle of the stripper plate to suit the conditions.

When no paper is fed:
Turn the dial to the left.

When multiple sheets of paper are fed:
Turn the dial to the right.

The paper separation pressure may not be properly adjusted.
When no paper is fed, the back of a card is damaged, or paper that can easily generate paper powder is used:
Turn the dial to "A little weak".

When multiple sheets of paper are fed:
Turn the dial to "Strong".

• When adjusting the angle, be sure to remove the paper from the standard tray and lower the standard tray all the way to the lowest position.

A multiple feeding error occurs although multiple feeding was not performed, or multiple feeding errors occur frequently.

You may be using dark colored paper or paper that is printed on one side.
When using paper that is printed on the back or paper with a dark base color, the machine may incorrectly detect this type of paper as though multiple sheets of paper are being fed. In this case, set [Double-feed Check] to [OFF].

For printing:

For copying:
[Storage] - [Save] screen ▶ select folder ▶ [Save Document] ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ set [Double-feed Check] to [OFF]

The paper becomes dirty. / Printing is not aligned properly.

The paper may be too dark for printing.
When printing on dark colored paper, the machine may not be able to detect the paper size, resulting in misaligned printing, image loss, or soiled paper edges. It is recommended that you use paper with a light base color.
Cannot print from a computer.

The [Online/Offline] setting may have been set to [OFF].
Check the [Online/Offline] setting on the [Print] screen.
If [OFF] is displayed, switch it to [ON].

- [Print] screen ▶ set [Online/Offline] to [ON]

The job may be a waiting job.
Jobs with a PIN code are handled as waiting jobs. The administrator may have configured the machine to handle all jobs as waiting jobs.
Check whether the job is displayed in [Waiting Job List] on the [Print] screen.

The machine may be busy printing another job.
- Idle jobs are printed in order from the top of the list on the [Active/Idle] screen.
- When the interrupt copy function is performed, the copy job has priority over the jobs sent from the printer driver.

Is the ink cartridge replacement message being displayed?
You cannot print if the message shows that even one color needs to be replaced. Replace the ink cartridge of the color shown.

Cannot print properly on irregular sized paper.

The irregular sized paper may not have been registered.
The paper size must be registered in advance in [Custom Paper Entry] on both the printer driver and the machine.

- Printer driver properties screen ▶ [Environment] tab ▶ [Custom Paper Entry]
The paper size must be registered in advance in the administrator menu on the machine by the administrator. Contact your administrator.

To use irregular sized paper without registering it as a paper size, enter the size of the paper in [Manual].

- [Print] screen ▶ select job ▶ [Change Setting] in the sub menu ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ [Paper Size] ▶ [Manual]

• When [ON] is not selected, the width and length of the paper size configured with [Paper Size] of the printer driver will be applied. When you use the irregular sized paper, registering the paper size beforehand will improve the print speed and paper alignment.

When printing a document with multiple pages, some pages are printed with an incorrect paper size.
The original data may include pages with different paper sizes.
Select the [Mixed Size Original] check box in the [Basic] tab on the printer driver screen. The paper tray is automatically selected according to the original size, and the document is printed.

It takes a long time to print. / When printing multiple copies, the printer makes a beep sound after each copy is printed.
The [Collate] check box may have been selected in the [Print] dialog box of the application.
Remove the check mark from [Collate] before printing.

The PIN code for a job is lost.
If you lose the PIN code, printing cannot be performed.
Add a new PIN code and send the data again. Contact your administrator to delete the job remaining in [Waiting Job List] on the [Print] screen.

[Full Color] and [Auto] are not displayed in the [Color Mode] menu on the printer driver screen.
The color printing function may be restricted.
Contact your administrator.
Cannot specify pages to print.
The [Collate] check box may have been selected in the [Print] dialog box of the application.
Remove the check mark from [Collate], and set [Sort] to [Uncollated] in the [Basic] tab on the printer driver screen.

Only one copy (page) is printed even though multiple copies (pages) are specified.
[Print and Pause] may have been set.
If [Print and Pause] has been set on the printer driver screen, printing stops after one copy (page) is printed.
If there is no problem with the print result, press the [Start] key on the operation panel or touch [Continue] on the touch panel to continue printing. To cancel [Print and Pause], remove the check mark from the [Print and Pause] check box in the [Basic] tab.

Part of the image is missing.
When creating a booklet or performing [Staple], the [Auto Reduction] setting may not have been configured.
When creating a booklet or using the staple/punch function, depending on the width of the margin, the printed surface may be cropped due to not fitting on the paper. In the [Finishing] tab on the printer driver screen, select [Booklet Binding] or [Binding Edge] and click [Details]. Select the [Auto Reduction] check box to automatically reduce the printed surface so that it will fit on the paper.

Cannot reprint a job on the [Job Status] screen.
Reprinting of the job may be restricted.
When reprinting of jobs is restricted in the administrator menu, reprinting cannot be performed. Contact your administrator for details.

After interrupting a job or turning the machine off and back on, it is unknown how much printing was completed.
You can check the number of copies and pages on the [Details] screen for a finished job.

Paper is loaded but the "Set paper." error message is displayed.
The [Paper Size] and [Paper Type] settings on the printer driver screen may not match the corresponding settings on the machine.
Even when paper is loaded, the error message is displayed if the [Paper Size] and [Paper Type] settings on the printer driver do not match those on the machine. Configure the same paper size and type settings on the machine as those on the printer driver.

[Auto Selection] may have been set to [OFF] for the standard tray or feed trays.
Configure [Paper Tray Setting] on the machine so that auto selection is enabled for the standard tray or feed tray that you are using.

The results of color printing are poor.
You may not be using paper that is suitable for printing.
With the inkjet system used by this machine, the printing quality (especially for color printing) may vary depending on the paper type. The machine uses the most suitable color profile setting for each type of paper when printing. As a result, if the [Paper Type] setting on the printer driver screen does not match the type of paper that is loaded in the machine, the full performance may not be achieved. Check the items below.

- When [Paper Type] has been set to [Any] on the printer driver screen, select the paper type that is actually in use. For more information, see “Paper Type” in the "User's Guide".
- Check that the type of paper loaded in the paper tray matches the paper type specified in [Paper Tray Setting].

[Job Status] key ➤ [Finished] ➤ select the job that you want to check ➤ [Details] in the sub menu
Printed images are light or faded.

The draft function may have been set.
If the draft function is set on the printer driver screen, the print density decreases because less ink is used. To increase the printing density, go to the [Image] tab and set [Image Quality] to [Standard].

The data compression function may have been set.
If the data compression function is set on the printer driver screen, the print processing speed increases, but fewer ink drops are used, making neutral colors appear uneven. To increase the printing density, go to the [Image] tab and set [Image Quality] to [Standard].

The paper edges become dirty.

[Printable Area] may have been set to [Maximum] in the administrator menu.
The inside of the machine may be soiled with ink. It is recommended that you use the [Standard] setting, particularly in cases where soiling appears after printing data containing an image that extends to the edge of the paper. Contact your administrator for details.

Images are bright or dark.

Correction may be required for data such as photographic images.
Select the [Gamma Correction] check box in the [Image] tab on the printer driver screen. Click [Details] and adjust the brightness and contrast on the [Gamma Correction] screen.

Duplex printing cannot be performed using the paper loaded in the standard tray.

The paper type for the standard tray may have been set to [Envelope].
When the [Thickness] setting in [Paper Type] is set to [Envelope], duplex printing cannot be performed using paper from the standard tray, regardless of the type of paper that is loaded. Configure the settings according to the paper to be used.

The sent data became a broken job.

You may be trying to output the job with other than the GD printer driver.
The data may have been printed out or saved using a printer driver other than the GD printer driver. Use the GD printer driver to send the data again.

The colors of a barcode background or nearby images cannot be printed out.

There may be an image in the barcode area, or the barcode area definition may be out of alignment.
In the area specified as the barcode area, regardless of the color of the original, the base color is printed in white, and the barcode, text and illustrations are printed in black. Check whether the barcode area definition is out of alignment, or whether any text or illustrations overlap the 1 mm (3/64") margin around the barcode. For more information, see "Barcode Area Definition" in the "User's Guide".

The layout order is not correct.

The [Combine] or [Booklet] settings may not be configured properly.
Check that the proper page order is specified for [Combine] or [Booklet] in the [Layout] tab on the printer driver screen.
Troubleshooting for Copying

This section describes how to troubleshoot problems related to copying.

**Part of the original is missing in the copied data.**

The [Reproduction Size] setting may not have been set properly.
Set the copy reproduction size to suit the combination of the original size and paper size.

[Copy] screen ▶ [Reproduction Size]

When creating a booklet, or when performing [Staple / Punch] or [Staple], the [Auto Reduction] setting may not have been configured.
When creating a booklet or using the staple/punch function, depending on the width of the margin, the printed surface may be cropped due to not fitting on the paper. Set [Auto Reduction] to [ON] under the margin settings to automatically reduce the printed surface so that it will fit on the paper.

**For booklets:**


**For staple / punch:**


**Duplex copying was performed, but the back of one or more pages is blank.**

Duplex copying may have been performed for an original consisting of different size pages.
When performing duplex copying of mixed-size originals, simplex (one-sided) copying is performed if the size of the original to be copied to the front and back of a sheet of paper is not the same size.

**Duplex copying cannot be performed for the paper loaded in the standard tray.**

The paper tray setting for the standard tray may have been set to [Envelope].
When the [Thickness] setting in [Paper Type] is set to [Envelope], duplex copying cannot be performed using paper from the standard tray, regardless of the type of paper that is loaded.
Configure the settings according to the paper to be used.

[Copy] screen ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ [Paper Type] ▶ [Thickness]
Troubleshooting for Scanning

This section describes how to troubleshoot problems related to scanning.

There is no scanned data on the scan screen of the RISO Console.

You may not have selected [Console] after touching [Scan] on the [Home1] screen. The scanned data is not displayed on the RISO Console if you select [Mail] or [PC] after touching [Scan], or when the scanned data is saved to storage. Select [Console] and scan the original again.

Part of the original is missing in the scanned data.

The [Scanning Size] setting may not match the actual size of the original. Set [Scanning Size] to the same size as the original, or set it to [Auto].

The [Page Size] and [Reproduction Size] setting may not have been set properly. Set [Reproduction Size] to match the combination of the [Scanning Size] and [Page Size] settings, or set [Page Size] to the same size as the original.

The color mode is set to [Auto], but the machine does not identify color originals automatically.

Automatic identification may not function normally for the types of originals listed below.

**Color original not identified:**
- A very lightly colored original
- A very dark or nearly black original
- An almost colorless original (only thin lines of color, etc.)

**Black and white original not identified:**
- An original in which the paper itself is not white

Select a color mode other than [Auto], or adjust [Color/Black Slice Level] in the administrator menu.

In the administrator menu, adjust [Color/Black Slice Level] (1 - 5)

Setting a higher value makes it easier for the machine to identify color originals. Contact your administrator for details.
This section describes how to troubleshoot problems related to saving and loading files to and from storage and USB.

For more information on problems that cannot be resolved using the information here, see “Troubleshooting for the Printer Driver and Printing” (p. 2-13), “Troubleshooting for Copying” (p. 2-16), and “Troubleshooting for Scanning” (p. 2-17).

**Files saved on a USB flash drive are not displayed on the printer.**

You may not have used the GD printer driver to save the files in PRN format.

To save a PRN file to a USB flash drive, go to the [Basic] tab on the printer driver screen and set [Output] to [Save to USB Drive].

- Files that are created and saved using an application cannot be printed in the format native to the application.

**Cannot print properly on irregular sized paper.**


To use irregular sized paper without registering it as a paper size, enter the size of the paper in [Manual].


- When [ON] is not selected, the sheet width is set to the width of the paper tray guide and the length is set to the maximum length of the relevant tray. When you use the irregular sized paper, registering the paper size beforehand will improve the print speed and paper alignment.

**Paper is loaded but the "Set paper." error message is displayed.**

[Auto Selection] may have been set to [OFF] for the standard tray or feed trays.

Configure [Paper Tray Setting] on the machine so that auto selection is enabled for the standard tray or feed tray that you are using.


**The results of color printing are poor.**

You may not be using paper that is suitable for printing.

With the inkjet system used by this machine, the printing quality (especially for color printing) may vary depending on the paper type. The machine uses the most suitable color profile setting for each type of paper when printing. As a result, if the [Paper Type] setting does not match the type of paper that is loaded in the machine, the full performance may not be achieved. Check the items below.

- Check that the type of paper loaded in the paper tray matches the paper type specified in [Paper Tray Setting].

- [Storage] - [Load] screen ➤ select folder ➤ select document ➤ [Change Setting] in the sub menu for the document ➤ [Paper Selection] ➤ [Paper Tray Setting] ➤ [Paper Type]

Duplex printing cannot be performed using the paper loaded in the standard tray.

The paper type for the standard tray may have been set to [Envelope]. When the [Thickness] setting in [Paper Type] is set to [Envelope], duplex printing cannot be performed using paper from the standard tray, regardless of the type of paper that is loaded. Configure the settings according to the paper to be used.

- **Part of the original is missing in the copied data.**

  The [Reproduction Size] setting may not have been set properly.
  Set the copy reproduction size to suit the combination of the original size and paper size.

  - **Storage** - [Load] screen ▶ select folder ▶ select document ▶ [Change Setting] in the sub menu for the document ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ [Paper Type] ▶ [Thickness]

  - **USB** - [Load] screen ▶ select folder ▶ [Open] ▶ select document ▶ [Change Setting] in the sub menu ▶ [Paper Selection] ▶ [Paper Tray Setting] ▶ [Paper Type] ▶ [Thickness]

  When creating a booklet, or when performing [Staple / Punch] or [Staple], the [Auto Reduction] setting may not have been configured.
  When creating a booklet or using the staple/punch function, depending on the width of the margin, the printed surface may be cropped due to not fitting on the paper. Set [Auto Reduction] to [ON] under the margin settings to automatically reduce the printed surface so that it will fit on the paper.

  For booklets:
  - **Storage** - [Save] screen ▶ select folder ▶ [Save Document] ▶ [Reproduction Size]

  For staple / punch:
  - **Storage** - [Save] screen ▶ select folder ▶ [Save Document] ▶ [Binding Margin] ▶ set [Auto Reduction] to [ON]

Part of the original is missing in the scanned data.

The [Scanning Size] setting may not match the actual size of the original.
Set [Scanning Size] to the same size as the original, or set it to [Auto].

- **USB** - [Save] screen ▶ select folder ▶ [Save Document] ▶ [Scanning Size]

The [Page Size] and [Reproduction Size] setting may not have been set properly.
Set [Reproduction Size] to match the combination of the [Scanning Size] and [Page Size] settings, or set [Page Size] to the same size as the original.

- **USB** - [Save] screen ▶ select folder ▶ [Save Document] ▶ [Page Size]

  - **USB** - [Save] screen ▶ select folder ▶ [Save Document] ▶ [Reproduction Size]

The color mode is set to [Auto], but the machine does not identify color originals automatically.
Select a color mode other than [Auto], or adjust [Color/Black Slice Level] in the administrator menu.


In the administrator menu, adjust [Color/Black Slice Level] (1 - 5)
Setting a higher value makes it easier for the machine to identify color originals. Contact your administrator for details.
Troubleshooting for the Multifunction Finisher and Face Down Finisher

This section describes how to troubleshoot problems related to the optional multifunction finisher and face down finisher.

Q The multifunction finisher or face down finisher does not operate.
- Make sure that the power plug is properly inserted into the electrical outlet.
- Make sure that the main power switch of the printer is turned on.
- Press the [Power] key on the operation panel to restart the machine. If the multifunction finisher or face down finisher still does not operate, contact your dealer or authorized service representative.

Q When you copy the original, the paper is stapled at the wrong position.

The orientation of the loaded original may not match the [Original Orientation] setting on the [Staple / Punch] or [Staple] screen.

- [Copy] screen ► [Staple / Punch] or [Staple] ► set [Original Orientation]
- [Storage] - [Save] screen ► select folder ► [Save Document] ► [Staple / Punch] or [Staple] ► set [Original Orientation]

[Auto Image Rotation] has not been set to [ON]. If it is set to [OFF], the machine cannot staple or punch the paper at the correct position.

- [Copy] screen ► [Auto Image Rotation]
- [Storage] - [Save] screen ► select folder ► [Save Document] ► [Auto Image Rotation]

Q Staples do not penetrate well, e.g., they bend or crush. / Paper is not output from the face down finisher.

There may be too many sheets for stapling.
- When using the multifunction finisher
  The number of sheets that can be stapled are as follows: 100 sheets for 85 g/m² (23-lb bond) A4 (Letter) or smaller paper, and 65 sheets for paper larger than A4 (Letter).
- When using the face down finisher
  The number of sheets that can be stapled are as follows: 50 sheets for 85 g/m² (23-lb bond) A4 (Letter) or B5 paper, and 25 sheets for A3 or B4 (Ledger or Legal) paper.

If staples do not penetrate properly when using the number of sheets specified above, contact your dealer or authorized service representative.

Q A staple is jammed inside the machine.

Follow the procedure described in “Stapler Jams (Multifunction Finisher)” (p. 2-21) and “Stapler Jams (Face Down Finisher)” (p. 2-23) to remove the staple.

Q Sheets come out loosely stacked on the face down finisher. / Printouts are curled back.

The tray position of the face down finisher [fixed position of ⤇ mark] may not be aligned properly.

Change the tray position depending on the paper type or output condition.
To print on many sheets in B5 size or smaller by offsetting or without sorting, set the fixed position of the ⤇ mark to the position shown below.
Stapler Jams (Multifunction Finisher)

If a staple becomes jammed inside the machine, follow the procedure below to remove the staple.

- Case of the staple cartridge UR1

1 Open the cover.

2 Hold the handle of the staple cartridge, and remove it by pulling it towards you while slightly lifting.

3 Open the staple cartridge cover and remove the jammed staple.

4 If the jammed staple cannot be removed, push the bottom of the staple cartridge in the direction of the arrow to remove the staple.

5 Return the staple cartridge to its original position.

6 Close the cover.

⚠️ CAUTION
Be careful not to injure your fingers when removing the staple.
Case of the staple cartridge UR2/UR3

1. Open the cover.

2. Pull out the unit by pulling forward while pushing the R2/R3 lever to the right.

3. Hold the latches on the left and right sides of the cartridge and pull up towards the left.

4. Remove the jammed staple.

5. Hold the latches on the left and right sides of the cartridge and attach the cartridge to the unit.

   - If not pushed in entirely, the cartridge will be loose, which may result in staples not being fed.

6. Return the unit to its original position.

7. Close the cover.

CAUTION
Be careful not to injure your fingers when removing the staple.
Stapler Jams (Face Down Finisher)

If a staple becomes jammed inside the machine, follow the procedure below to remove the staple.

1 **Open the staple cover.**

2 **Hold the handle of the staple cartridge, and pull it toward you.**

3 **Open the staple cartridge cover, and remove the jammed staple.**

4 **Return the staple cartridge to its original position.**

5 **Close the staple cover.**

⚠️ **CAUTION**

Be careful not to injure your fingers when removing the staple.
Troubleshooting for the Feed Tray

This section describes precautions for using the feed tray.

!? Paper is jammed in the feed tray. / The tray cannot be pulled out smoothly.

You may need to pull out the feed tray to remove paper jammed at the far end of the feed tray. There is a spring on the right side of the feed tray. When pulling the tray out, hold it in the way shown below, without touching the spring.

1 Pull the tray until it stops.
2 Lift the front side of the tray diagonally upward, and pull out the tray.
3 Remove the jammed paper.
4 Align the white projections on both sides of the tray with the rails, and return the tray.

Lift the front side of the tray diagonally upward, and insert it into the rails. Next, lower the tray to the horizontal position, and push it in.

• To hold the tray with proper balance, place your right hand on the front cover part of the tray, and place your left hand on the left near the back, diagonally across from your right hand. If you hold the front part with both hands and pull the tray, the back end may drop due to the weight of the tray.

How to Load A3 (Ledger) Paper and B4 (Legal) Paper

Install the paper guides in the proper position for the paper size that you are using. To change the position of the paper guides, pinch both sides of the paper guide, slide it out and then slide it into the appropriate hole for the desired paper size.
Troubleshooting for the High Capacity Feeder

This section describes how to troubleshoot problems related to the optional high capacity feeder.

? Although the paper in the high capacity feeder has run out, the standard tray does not descend to its lowermost position and stops midway.

To lower the standard tray, press the standard tray descent button. Hold down the standard tray descent button to lower the standard tray to the position you wish to lower it to.

- The position to which the standard tray is lowered when paper runs out or when the standard tray descent button is operated can be set in the administrator menu.

? The paper feed guides cannot be adjusted and cause the paper to bend, warp, or be misaligned.

If a large amount of paper is set at once, the paper feed guides have trouble adjusting and being properly set. (Paper is not aligned because paper is bent or warped.) Load a single pack of paper and load the rest of the paper after adjusting the paper feed guides. For more information on loading a large amount of paper at once, see “When Setting a Large Amount of Paper at Once” in the "User’s Guide".

Troubleshooting for the High Capacity Stacker

This section describes how to troubleshoot problems related to the high capacity stacker.

? The stacking tray does not descend and it is difficult to remove the printouts.

To lower the stacking tray, press the stacking tray descent button. By pressing the stacking tray descent button, the stacking tray will descend to the position at which the carriage is set (lowermost position).

- Pressing the stacking tray descent button while the stacking tray is descending will stop the descending of the stacking tray.
- Be sure to press the stacking tray descent button when both the right and left covers are closed.
- The position to which the stacking tray is lowered when a print job is completed or paused can be set in the administrator menu.

? The stacking tray descends each time a job is printed and it is not possible to continuously print.

The position to which the stacking tray is lowered upon completion of a printing job may be set to [Lower to the carriage] / [Lower to the specified position].

The stacking tray will not descend if [Do not lower] is set for [High Capacity Stacker] in the administrator menu. Contact your administrator for details.
Troubleshooting for the IC Card Reader

This section describes how to troubleshoot problems related to the IC card reader.

ению Unable to log in using the IC card.

Another card, such as one that is in the same carrying case, may be interfering with the IC card that you are trying to use.
If the cards interfere with one another, you may not be able to log in using the IC card.

You may not be holding the IC card to the reader properly.
If the IC card is too far from the IC card reader, the IC card is not recognized, resulting in authentication failure.

The USB cable of the IC card reader may not be properly connected.
If it is not properly connected, you may not be able to log in using the IC card.

The information on the IC card may not have been registered on the machine.
• The IC card must be registered by the administrator in advance. Make sure that the administrator has registered your IC card.
• The attribute of the external server which is used for IC card authentication is not set correctly. For more information on what action to take, contact your administrator.

A registered IC card is lost or missing.

Contact your administrator immediately.
The IC card allows the user to log in to the machine and print documents. If your IC card is used by an unauthorized third party, the activities will be recorded under your name. If you notice that your card is missing, contact your administrator immediately.
Other Problems

The front cover does not open.
The front cover can only be opened when an error such as ink cartridge replacement or paper jam needs to be resolved.
To open the front cover when an error has not occurred, press [Front Cover Release].

[Home1] screen ➤ [Maintenance] ➤ [Front Cover Release]

The correct user name is not displayed when touching the index button on the [Login] screen.
The administrator may not have properly configured [Index] in [User Setting].
Contact your administrator.

A job with a PIN code cannot be deleted.
To delete a job with a PIN code without entering the PIN code, you need to log in as the administrator.
Contact your administrator to delete the job.

The printer does not wake up automatically.
If you try to print in a network environment where Wake On LAN communication is not enabled, the printer does not wake up automatically due to the sleep level setting configured by the administrator.
Click [Get Printer Info] on the printer driver screen and configure [MAC Address of the Printer].

Printer driver properties screen ➤ [Environment] tab ➤ [Get Printer Info]
For more information, see "Wake On LAN" in the "User's Guide". Otherwise, contact your administrator.

The RISO Console screen is not displayed.
The IP address of the machine may not have been entered correctly in the web browser.
Enter the correct IP address. You can check the IP address of the machine by touching [System Info] - [Machine Info] from the [Home1] screen.

The machine may be in sleep state.
The sleep level that the administrator configured in [Power Saving Setting] may not allow you to activate the RISO Console. Press the [Wake Up] key to put the machine back into an operational state, and then activate the RISO Console.
For more information on the power saving setting, contact your administrator.
The [Ink Information Input] screen is displayed.

Follow the on-screen instructions to enter the set values.
To ensure optimal printing quality, the machine obtains information from ink cartridges. If the information cannot be obtained properly, enter the appropriate values on the [Ink Information Input] screen.

- If you replace the ink cartridges or you press the [Power] key on the operation panel to restart the machine, the set values entered on the [Ink Information Input] screen disappear. Reconfigure the ink cartridge information.

If the [Ink Information Input] screen is displayed, it means that a non-RISO ink cartridge has been installed. To continue using the non-RISO ink cartridge, enter the appropriate values referring to the following table.

<table>
<thead>
<tr>
<th>Message</th>
<th>Setting/Description</th>
<th>Set value/Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a temperature adjustment setting for the set ink.</td>
<td>To make the optimal printing available, set the monitor range of the printable temperature for the ink.</td>
<td>[1] (30 °C - 40 °C) [2] (30 °C - 45 °C) [3] (25 °C - 45 °C) [4] (20 °C - 45 °C) [5] (20 °C - 40 °C)</td>
</tr>
<tr>
<td>Select a cleaning operation for the set ink.</td>
<td>Set the utmost cleaning cycle for the ink which will not cause the defective printing.</td>
<td>[1] (500 to 700 sheets) [2] (500 to 1500 sheets) [3] (500 to 3000 sheets) [4] (500 to 5000 sheets) [5] (500 to 5000 sheets)</td>
</tr>
<tr>
<td></td>
<td>- If the set value exceeds the maximum number of sheets, the cleaning cycle setting confirmation screen appears.</td>
<td>The default values are different between [4] and [5] while their selectable ranges are the same. [4]: 2000 sheets [5]: 3000 sheets</td>
</tr>
<tr>
<td>Set the recommended Use By date of the ink cartridge.</td>
<td>Specify the year and month to make the message appear to indicate that the expiration date of the ink comes close.</td>
<td>[Month]: 1 - 12 [Year] (last two digits): 00 - 99</td>
</tr>
</tbody>
</table>
Troubleshooting for the Optional PS Kit

This section describes how to troubleshoot problems related to the PostScript 3 printer driver and printing.

Files saved on a USB flash drive are not displayed on the printer.

The PDF files may have been saved to a folder created by the GD printer driver.
PDF files saved to a folder created by the GD printer driver are not displayed.
Save PDF files directly to the USB flash drive without creating a folder, or save them to a folder that you created beforehand.

It takes a long time to print when using Mac OS. / Printing cannot be performed with the current settings.

The [Collate pages] check box may have been selected in the [Print] dialog box of the application.
Remove the check mark from [Collate pages] before printing.

When using Mac OS to print a document with multiple pages, some pages are printed with an incorrect paper size.

The original data may include multiple paper sizes.
When printing original data that includes multiple paper sizes, the paper size of the first page is used for the remaining pages. As a result, pages that are a different size than the first page may not be printed properly, or part of the image may be missing.

When printing a PDF file directly from a USB flash drive, a paper with the texts "Implementation limit exceeded" is printed out.

Does the original include high resolution images?
Printing the original with high resolution images may not be possible since processing takes too much time.
Recreate the original with images that are lower in resolution and send the data again. If printing is still not possible, contact your dealer or authorized service representative.
Chapter 3 Maintenance

Replacing the Staple Cartridge

When there are no more staples, printing stops and a message is displayed on the touch panel. Follow the procedure below to replace the staple cartridge.

Replacing the Staple Cartridge UR1 (Multifunction Finisher)

1 Open the cover.

2 Hold the handle of the staple cartridge, and remove it by pulling it towards you while slightly lifting.

3 Push the area indicated with arrow ① to open the staple cartridge cover.

4 Remove the staple case.

5 Place a new staple case in the staple cartridge.

- The staple replacement message may appear even if there are staples remaining. Even so, replace the staple case anyway. The remaining staples can be used.

- Align the direction of the arrows and set the staple case.
6 Pull out the tape from the staple case.

7 Close the staple cartridge cover.

8 Return the staple cartridge to its original position.

9 Close the cover.

---

Replacing the Staple Cartridge UR2/UR3

- The staple replacement message may appear even if there are staples remaining. Even so, replace the staple case anyway. The remaining staples cannot be used. Please take note of this.

---

1 Open the cover.

2 Pull out the unit by pulling forward while pushing the R2/R3 lever to the right.

3 Hold the latches on the left and right sides of the cartridge and pull up towards the left.
4 Hold the latches on the left and right sides of the new cartridge and attach the cartridge to the unit.

Firmly press down on the center (round indentation) of the cartridge.

- If not pushed in entirely, the cartridge will be loose, which may result in staples not being fed.

5 Return the unit to its original position.

6 Close the cover.

Replacing the Staple Cartridge (Face Down Finisher)

1 Open the staple cover.

2 Hold the handle of the staple cartridge, and pull it toward you.

3 Press the area indicated by arrow 1 to release the hooks and remove the staple case.

- The staple replacement message may appear even if there are staples remaining. Even so, replace the staple case anyway. The remaining staples can be used.
4 Insert the front part of the new staple case into the cartridge, and then insert the back part.

5 Return the staple cartridge to its original position.

6 Close the staple cover.
Cleaning the Punching Box

When the punching box becomes full of punching trash, printing stops and a message appears on the touch panel. Use the following procedure to remove the punching box and dispose of the punching trash.

- When removing the punching box, be sure to dispose of all punching trash. If punching trash remains inside the punching box, the punching box may become full before the message for replacement appears, causing a malfunction.
- Be sure to perform this task with the power of the machine turned ON. If the machine is not turned ON, the machine will not recognize that the punching box is empty. When the machine is in the sleep mode, press the [Wake Up] key on the operation panel.

Disposing of the Punching Trash

1. Open the cover.

2. Remove the punching box by pulling it forward.

3. Discard all of punching trash.

4. Return the punching box back to its original position.

5. Close the cover.
Simple Questions

A message indicating that one ink cartridge must be replaced is displayed. Can I continue printing?

No, you cannot. Printing resumes after the empty ink cartridge has been replaced. The job data will not be lost when printing is stopped because of an empty ink cartridge.

Can I load different size originals together into the ADF?

You can scan different size originals together which have one side of equivalent length. Set [Mixed Size Original] to [ON].

How do I turn off the operation sounds?

The confirmation and error sounds can be turned on or off in the [Beep Sound] setting in the administrator menu.

Contact your administrator.

How should the original be loaded when using [Top Side Up] and [Top Side Left] in the [Original Orientation] setting?

[Top Side Up] | [Top Side Left]
--- | ---
Load the original in the same orientation as if you were reading it. | Load the original with the top of the page on the left side.

The machine logged me out even though I did not perform any action.

The [Auto Logout Time] setting has been configured for [Login Setting] in the administrator menu. [Auto Logout Time] can be set to between 10 and 3600 seconds.

Contact your administrator.
I have to wait before using the machine, because it is always in sleep state when I try to use it.

The [Auto Sleep] setting has been configured for [Power Saving Setting] in the administrator menu. The machine automatically enters sleep state after a fixed period (1 to 60 minutes).
Contact your administrator.

What is the [Offset Output] setting?

This function enables the machine to stack each set of printed documents slightly apart from each other when they are output, making them easy to separate.
This setting is available when the optional multifunction finisher, face down finisher, or high capacity stacker is connected.

Can I print without my IC card?

Certain [Login Method] settings configured by the administrator may allow you to log in using an IC card or PIN code. Depending on the setting, you may be able to log in without the IC card if you enter the PIN code.
Contact your administrator.

Can I print without a margin?

No, you cannot. Printouts always have a blank margin, regardless of the data size.

What is the Storage function?

The Storage function enables scanned originals or print data sent from a computer to be saved to the internal hard disk of this machine. This function is useful for saving documents that are printed frequently.

How can I check the current status of a job, or the details of completed jobs?

Press the [Job Status] key on the operation panel. The [Job Status] screen is displayed. You can check the details of jobs that are being processed, idle jobs, and completed jobs.

How can I check the IP address of this machine?

You can check the IP address of the machine by touching [System Info] - [Machine Info] from the [Home1] screen.

How can I reduce ink setoff?

Set [Image Quality] to [CMY Print] in the [Image] tab on the printer driver screen. The fixation of ink will improve and help prevent ink from transferring onto adjacent sheets.
Please contact the following for supplies and service: